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Introduction 
Throughout this guide we will be referring to the following: 

Scenes 
A Scene is the setup file (‘.SCN’ file) which defines the layout of the graphical overlay 
and sets the system parameters such as PAL/NTSC, CAN channels, lap-timing 
information etc. 
 
Elements 
These are graphical items in the scene, such as gauges, text, picture-in-picture, bar 
graphs, Track maps etc. 
 
 

 

Scene Files 
If you want to move Scene files around, use the File > Export and File > Import 
functions which package up all the image and configuration files into a single 
compressed folder, allowing them to be easily sent to other users or transferred to 
another computer. 
 
The Scene files which come as part of the software package, and any scenes you save 
locally using File > Save in the software, are stored in the PC users program data 
storage area as a folder of images and configuration files.  
 
 
Location of Program data in Windows 7 and Windows 8 
 C:\Users\USER_NAME\AppData\Local\Racelogic\VVB\Themes\Default\SCENES 
 

Location of Program data in Windows XP 
C:\Documents and Settings\USER_NAME\Application Data\Racelogic\VVB\Themes\Default\SCENES 
 

Note: Some of these directories may be hidden, so you will need to change your systems settings to show hidden 
folders. Generally, a user will not have to do anything with this kind of file, if you want to move scenes around, Export 
and Import should be used instead. 
  

A Typical Scene 

An element within a scene 
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Loading Scenes into a Video VBOX 
You can upload a scene to the Video VBOX by using the Upload via SD card button or the Upload via USB button. 
When using the SD card, simply insert the card with the scene into the 
Video VBOX, and it will be installed automatically.  
 
The scene file will be deleted unless a blank text file called ‘no-delete-scene.txt’ is on the card, this is to program 
multiple boxes with the same scene. 
 
You can download a scene file from a Video VBOX using USB by using File > Download scene from Video VBOX 
 

Loading Multiple Scenes into a Video VBOX 
The Video VBOX can store up to eight user configurable scenes. They are loaded by placing them in the root folder of 
an SD card and inserting them into a VVB. The user can select the scene using an OLED display.  
 
Note: if the user tries to load more than eight scenes, the Video VBOX will reject all the scene files and write an error 
message to the SD card.  
 
 
Loading multiple scene files must be done in 
one single upload. The scene section cannot 
be added to, only replaced with one new 
scene or another multiple selection.  
A default scene will remain in the unit at all 
times.               
 
Only the scene which is currently loaded into 
the Video VBOX can be downloaded via USB 
using Video VBOX setup software. If the 
software is used to upload a scene it will 
overwrite the current active scene - other 
scenes are not affected. 
 

Fonts 
Some free scenes will require installation of either shareware or commercial Fonts. You can download most fonts at 
www.fonts101.com (free fonts) or www.fonts.com (commercial). If you do not have the correct font, the software will 
substitute a default font which already exists on your PC, which may result in a compromised layout. 

Software Installation 
Install the software using the CD provided, or download the latest version from our website: 
www.vboxmotorsport.co.uk under the section Customer Area. 
  

http://www.fonts101.com/
http://www.fonts.com/
http://www.vboxmotorsport.co.uk/
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User Guide 

Adding a logo or image 
To add an image (e.g. Sponsor’s Logo) to the scene, select the Elements tab > Static Image > New.  A file selection 
window will then appear. 

 
To move the image, select it, then click 
and drag on the body of the image.  
 
To re-size this image, click and drag the 
bottom right hand corner. To maintain 
the original aspect ratio, hold down the 
SHIFT key.  
 
Note that if you make the image larger 
than the original, then the quality will 
suffer. 
 
You can load in .jpg, .png, .gif or .bmp 
files. If you want transparent parts of 
the image, use a .png or a .gif. 

 

 

Track maps & lap-timing 

Inserting a track map 
With a built-in database of almost every circuit in the world, it is 
very simple to display lap-times and a Track map. 

To use, select Track Map from the Elements tab. 
Then, select the country and circuit from the list.  
 
 
 
 
 
 
 
 
 
A track map of that circuit will then appear in the scene, 
which can be moved by clicking and dragging. You can also 
resize the track map by dragging the corners. 
 
 
The track properties tab (highlighted) can also be used to 
change the colour, thickness and track pointer image. 
 
  

Drag corner to resize 
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Auto Track Map Elements 
An Auto Track Map element uses the current GPS co-ordinates to search the track map database and automatically 
loads a circuit map and start/finish line.  
 
If an OLED is connected to the VVB, the start/finish line will be automatically synchronised.  

 
An ‘Auto Track Map’ element must be 
added to the Video VBOX scene and 
uploaded to the Video VBOX. The size 
of the auto track map is fixed and will 
appear in the centre of this box.  
 
To add an auto track map element to 
your scene, select ‘Auto Map’ from the 
elements list, and then click the ‘New’ 
button.  
 
You can specify the image used as a 
track position indicator. The default is a 
red dot. 
 
 
 

If multiple circuit layouts are found at the current GPS location, you can select any of the matching tracks using an 
OLED display.  

 
 
For some tracks, a ‘combo’ map is available which will cover all circuit 
layouts. 
 
 
 
 
 
When a location is detected, the VideoVBOX will check for a ‘combo’ track 
from the database.  
 
If there is not a ‘combo’ map available for the location, it will default to the 
first track in the list alphabetically. 
 
 
  

Combo Map example - Rockingham 
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Setting the start/finish line for Lap-timing 
If you use a Track map from the database, then the correct start/finish line from the database will be used 
automatically. 

 
 
 

Ignore start line count 

This value allows for a parade lap or warm-up lap 
to be ignored in the total lap count.  

 

 
 
 
 
 
 
 

 

Creating your own Track map 
If you want to create your own Track map, record either a small 
number of laps around the circuit, or drive around the inside and 
then the outside of the track and then save this ‘.vbo’ file onto 
your PC. 
 
Now select Track Map from the Elements tab, but choose User 
defined and select the file you have just created. 
 

 

Creating your own start/finish line 
You can create your own start/finish file using the start/finish wizard in 
Circuit Tools, supplied with your Video VBOX. Please refer to the Circuit 
Tools manual for instructions on how to create a split file containing this 
information. 
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Using your own start/finish line 
 
In the Video VBOX Setup software, a user created Split file can be 
loaded into the Scene using the Scene properties tab under Lap 
Timing > Load, from there you can choose the file (either from the 
built-in Database or your own file). 
 
 
 
 
 

 

 

Downloading Track maps 
Video VBOX Setup Software includes the latest Track Database available at release. Updates to this database are 
available from our website: www.vboxmotorsport.co.uk in the Customer Area. 
 

 

Creating a circuit map using Google EarthTM 

 
You can use Google Earth to draw around your track using the 
Add – Path tool.  
 
Save this path as a ‘.kml’ file by right clicking on the entry in 
the ‘Places’ tab, and changing from ‘.kmz’ to ‘.kml’ 
 
 
Import this ‘.kml’ file into VBOX Tools or Performance Tools 
software using File - Import - From Google Earth.  
 
Then save this file as a ‘.vbo’ file and use this in the Video 
VBOX Setup software as the Track map in the same way as 
before. 
 
An application note describing this procedure in more detail is available from the VBOX website in the Customer Area. 
 
  

http://www.vboxmotorsport.co.uk/index.php/en/customer-area/circuit-tools-track-database
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Adding a lap-timing element 
Note: To enable lap-timing, you must first have a relevant start/finish line corresponding 
to your track as described previously.  
 
(You do not need a Track map to get lap-timing to function, but this is the easiest way to use the built-in database.) 

 
To add a lap-timing element, first insert a Text 
element using the Elements tab – Text - New  
 
Under Text Properties 
select Lap Timing in the 
Parameter pull down 
menu, and then you can 
select which parameter 
is displayed.  
 
In this case we have 
current lap (rolling time) 
as the main display. 
 
 
 
 

The font, size and colour can be selected in the same tab. If you want the main lap-timing display to hold the current 
lap-time as you cross the line for a short period of time, then enable the Secondary display with Finish lap as the 
trigger and Last lap time as the parameter. 
 
If you are using an OLED display the start/finish data you have loaded into the scene will be transmitted to the display 
automatically, look out for the message Start/Finish and splits synchronised OK. If you have configured a scene with 
no start/finish line included, you can set one on the OLED display, which will then be imported into the scene. 

Predictive Lap Timing Element – for use with OLED or LapTimer 
If an OLED display or LapTimer is connected to the Video VBOX, then the predictive lap 
timing calculated in the OLED can be displayed in the video overlay.  This can be added in 
the same way as a lap-timing element, but predictive lap timing must be selected as the 
main parameter. There is the option of displaying the reference lap time, or the delta-t 
channel. 

Gauges 
A Gauge can be any shape, but is typically circular with a 
rotating needle. 
Gauges can be used to display any of the available GPS or 
CAN/input module parameters such as speed (GPS), RPM 
(CAN/module) etc. 

Using a supplied gauge 
There are a number of preconfigured gauges which have 
different ranges and styles which can be inserted into the 
scene by dragging and dropping. 
 
You then need to configure the parameter which is displayed, and the units using the Gauge Properties section 
(highlighted). 
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Custom Gauge Creation 

Creating a new Gauge 

Select the Elements Tab on the right hand side. 
Select Gauge, then use the New button 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Choosing a background 

The background of the gauge is the face of the element, it can be a .bmp, .jpg or .png file. It can contain the numbers 
for the gauge, or it could be blank, with the numbers being added in afterwards. Examples: 
 
 
 
 
 
 
 
 
 
Click Load Background and select an image file for your gauge background. If no background is required, click the 
Transparent check-box.   

Blank gauge 
Gauge Properties 

Load background 
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Assigning a needle 

 

Once a background has been selected, you can now load a needle. The needle 
is a simple vertical image of a needle and must not have any spare space or 
borders around the image. 

 

 

 

 

 

 
 

Positioning the Needle 

 

 

 
 
 
 
 
 
 
 
 
 

Drag the needle to the centre of the gauge 
 

 
 
 
 
 
 
 
 
 
 
 
 

Drag the crosshair to the rotation point of the needle 
 

Load needle 

Too big Not vertical Perfect! 
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Setting the needle direction 

 
 
 
 
 
 
 
 
 
 

 

Defining the range of the needle 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Multiple Needle Rotations 

If multiple rotations of the needle are required, enter the number of full 
rotations required here. If partial rotations are required, the Set Minimum 
and Set Maximum function can be used. 

 

 

 

Set maximum 

Set minimum 

Move slider so needle 
shows minimum 

Move slider so needle 
shows maximum 
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Assigning a parameter to the gauge 
 
You can use any logged parameter to display on the gauge, select from the 
Needle menu under Gauge Properties. 

Changing the units (e.g. from MPH to Km/h) 

You can change the units of the parameter using the drop down menu. 

 

 

 

Setting the parameter range 

Set the maximum and minimum values to 
match the face of the gauge. Note you do not 
have to start at zero. 
 
 
 
 
 

 
 

 

Speed labels 

The most flexible gauge to use is a blank gauge without any numbers. To 
use this element, just drag and drop this gauge from the Elements tab 
onto your scene. Then you can add the speed labels around the gauge 
using the Label element type.  
 
The speed range does not have to start from zero, it can go from 25 to 
125 for example, but make sure you set the Min (25) Max (125) range 
under Background for this element. Note that the needle will always be 
drawn over the top of any other element. 
 

 

Moving gauges around 

By clicking and dragging a selection box around a number of elements you can 
create a temporary group, which can then be dragged anywhere on the scene as 
one item. You can also copy and delete multiple items using this method, just 
right click over the grouped elements to bring up a menu of functions. 
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Creating a Single Bar Graph 

A Single Bar Graph is a rectangular gauge 
with an expanding bar which can be used 
to display any data available from GPS or 
CAN such as Lateral Acceleration (GPS), 
Engine Temp (CAN) etc.  
 
 
To create a single bar graph, use the 
Elements tab -> Single bar graph -> New  
 
 
The bar graph element consists of two 
items, the background containing the 
scale and outline, and the parameter 
associated with the bar graph. 
 
The direction, colour, range and marker 
(moving pointer), can all be changed using 
the Gauge Properties tab. 

 
 
 
 
 
 
To change the position, height and width of the fill, simply click and drag the corners of the 
coloured bar. 
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Creating an XY (G-force style) Bar Graph   
A Double Bar Graph is created in a similar way to the single 
bar graph using the Elements tab -> Double bar graph -> New 
 
The default parameters for this element are Lateral 
acceleration on the X axis and Longitudinal acceleration on 
the Y axis. 
 
 
 

 
 
The direction, individual axis colours, 
associated parameters and ranges are all 
adjustable using the Double Bar Graph 
properties tab (highlighted). 
 
To change the 
position, height 
and width of the 
fill, simply click 
and drag the 
corners of the 
coloured bar. 
  
 
 
 

 

Creating a circular XY (G-force style) gauge 
A circular XY Gauge can be used to show G-force as a moving dot. It is created in the 
same way as the Double Bar Graph but using Elements tab - XY Plot - New 
 
 

 
 
 
 
The displayed parameters, ranges and 
dot type are all adjustable using the XY 
Plot properties tab. 
 
 
 
 
 
 
 
 
 
 

  



 
VIDEO VBOX MANUAL 
 

 

 

      
Page | 18   26 August 2014 

Creating and setting up a Display Range element 
The display range element can be used to show changing text or images depending on the value of a parameter. One 
example use for this element is to display which Gear is being used. To create a new Display Range, use the Elements 
tab > Display Range > New. This will give you a blank element.  

 
Example - Showing current gear from RPM and Speed 

 
Setting this up is a two stage 
process.  

First, create a Maths channel to 
calculate RPM divided by Speed.  
Add this to a text element on the 
video and record a short journey 
using every gear.  

Review the video and identify 
ranges for each gear. 
For example, you may find 1st gear 
gives a value of 0.1, 2nd gear gives a 
value of 0.2. 

This defines the ranges to use for 
your gear selection. 

 

 
The maths channel must now be assigned to the display range 
element. This is done in the Background section and altering 
Parameter to the maths channel. 

 

 

 

A value can be entered to test how the element 
will work. 

 

Default image/text - this will display when none 
of the range values are true, e.g. neutral for a 
stationary vehicle. 

 

The calculated range values for each gear must 
be entered here along with the image/text 
chosen to be shown when the specified range 
value is true. 
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Adding a Picture-in-Picture element 
A second camera can be used to display an additional image. In this example on the 
right, the driver is shown. To add a Picture-in-Picture element to the scene, use 
Elements tab > Picture in Picture > New  
 
To adjust the size of the element, click and drag the corners. To change position, click 
and drag the whole element. To keep the aspect ratio correct, either mark the tick box 
under PIP properties, or hold down the SHIFT key whilst re-sizing the window. 

Cropping a PiP Element 
Connect the Video VBOX via USB to the PC. 

Select the PiP Element to be cropped and check 
the Crop Image box in PiP Properties. 

Connect the camera that feeds the PiP to CAM1 
port on the Video VBOX and select EDIT. 

An Output Preview window will launch with the 
image feed from the camera. Drag a box across 
the area to be cropped and click OK. 

 

 

Flipping a PiP Element 
To flip a PiP element select the element and click the relevant checkbox in 
Picture in Picture Properties. 

 

Adding text elements 
Text elements can be used to display any GPS or CAN 
parameter.  To create a new text element use Elements tab -> 
Text -> New. 
 
Under the Text Properties tab, (highlighted) you can select the 
associated parameter. 
 
The font, colour and size can be also be changed this tab.  
 
Using a Mono-spaced font stops keeps the numbers neatly 
aligned as they change value. Keep the size 16 or above so it 
can be seen clearly on the video. 
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Adding a solid background to text using the Simple Shape element 

 
With the ‘Simple Shape’ element, you can easily add a coloured 
background to make text more visible over the video. This element has a 
selectable transparency. 

So that the shape does not cover the text element completely, it needs 
to behind any text, and this is done by right clicking the Shape element 
and selecting Send to back.  

 

To create a new simple shape element, use the Elements tab > 
Simple shape > New 

The transparency level and shape can be altered in the Simple 
shape properties tab. 

The dimensions of the shape can be altered by clicking and 
dragging the bottom right hand corner of the element. 

 

Adding a static text label 
To add non-changing text to the scene, select Elements tab - Static Label – New 
 

 
 
 
The text, font, size, appearance and 
colour can be changed using the Static 
Label properties tab. 
 
 
 
 
 
 

 

 

 

Exporting and Saving Elements 
Once an element has been created, such as a gauge, bar graph, Track map etc., you can save 
this element for use in a different scene. To do this, select the element and right click the 
mouse button and select Save. To share the element with someone else, then use Export as 
this packages all of the files into a single ‘.ELM’ file. 
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Layers  
Each element that is added to the scene is put on a new layer and each new layer appears above the previous layer. 
You can change the order of the layers using the Layers tab. 
 

 
In this example, four Lap-timing elements have been created first, followed by 
a gauge. The gauge now obscures the text elements (even though it is slightly 
transparent). 
 
 
To correct this, select the Layers tab and click and drag the Gauge layer 0 to a 
point past layer 4. 
 
 
 
 
With the gauge now occupying layer 4, the lap-timing elements are now more 
visible. 
 
 
 

 

Groups 
If you have multiple elements which are part of one item, then you can 
group them together which makes moving, deleting, copying and pasting 
much easier. 
 
Using the previous example, you can group all of the lap-timing elements 
into one group. To do this, select the Layers tab and hold the CTRL key 
down and select the layers you wish to group. Once they are selected, 
right click and select Add to group. You will then be prompted for a name 
for this group. 
 
You can now select any element of this group and move them all at once.  
 

Groups are represented in different colours in the Layers 
tab. 
 
It is also possible to add/remove an element to/from a 
group by right clicking on an element in the preview 
window. 
 
 
 
 

To create a temporary group, simply hold down the left hand mouse button and drag around multiple elements. They 
will then be locked together until another item is selected. 
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Saving a Group 
Once a group has been created, it can be Saved or Exported for 
use in other Scenes. In this example we are saving just the Lap 
Timing Elements. 

To Save a Group of Elements, first select all the Elements to be 
saved and right-click on this selection. 

Select Save Group, name your Group and select 
Save. 

This saved Group will now be available to import 
from the Elements tab by selecting Grouped from 
the Select Element type dropdown. 

 

 

Note: it is not possible to edit an element within a saved group. The element must be 
removed from the group before it can be edited. This is done by Right-clicking the 
element and selecting Remove from group.    

 

 

Video Preview via USB 
By connecting the Video VBOX to your PC via the USB cable, you can preview the video output to allow you to check 
and align your cameras to make sure they are straight. To do this, select Video – Download output preview from 
Video VBOX.  
 

This will cause a floating window to appear with a video 
snapshot. You must have installed the software USB drivers 
in order for this function to operate. 
 
Note that the preview updates every few seconds, it is not 
live video. 
 
You can load this image into the background of the scene to 
check the best placement of the gauges, this is done using 
Video - Download preview into background. 
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Performance tests 
Performance tests can be displayed live on the Video Overlay showing acceleration times, Vmax and braking times. 
 
To display a performance test result, place a Text element on the scene and under Text Properties, select 
Performance tests from the Parameter drop down box: 

 
 
 
 
 
 
 
 
 
 
 
 

 
There are a number of pre-defined tests already included, you can edit these and create your own in the Scene 
Properties tab under Performance Tests: 
 

 

 
 
 
 
 
 
The type of test and the value displayed (Time taken, distance etc.) can then be chosen from drop down menus. The 
font, colour, size and format can all be changed from the same Text Properties tab. 
 
Mid Speed allows you to create a two part test, such as a 0-100-0. 
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Maths Channels 
Maths Channels can be used to create a new channel to be displayed using a combination of the existing parameters. 
An example may be hill gradient which can be calculated from the horizontal speed and the vertical speed. 
 
 
 
Click on Add new under Maths Channel in the scene Properties tab 
 
The equation is then entered into the 
Maths Channel setup window. 

 

Select parameters by clicking on the 
relevant button in the Data Sources tab. 

 

 

 

 

 

 

Once a Maths Channel has been defined, you can assign a Text 
element to use this Maths Channel in the Parameters drop down 
menu in the Text Properties tab:  
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Scene properties 
There are a number of additional parameters in the 
Scene Properties tab which are described below. 
 
 
 
 
 
 
 

 

Grid Setup 
This allows you to change the spacing on the grid shown in the main view 
window.  

System Info 
By default, the Video VBOX uses UTC time which is Greenwich Mean Time. You can adjust for your local time by 
changing the Local time offset. Values can be +ve or –ve, and this applies to the file time, displayed local time and 
filename (if you use time and date for naming of your files).  

 
Smooth level Settings 
Here you can set levels of smoothing to selected channels to help reduce noise. This smoothing is applied to the 
channels before they are logged to the VBO data file or 
displayed in the scene. 
 
 
 
 

GPS Settings 
These are the correct settings when using a standard 10Hz VVB unit. 

To use DGPS modes, 20Hz VVB Pro hardware is required.   
  

To use the setting for 40cm accuracy, a Base Station is required. 
 
To use the setting for 20cm accuracy, a firmware upgrade is required as well as a 
Base Station. 
 
If the SBAS setting is selected, the VVB unit will use GPS and SBAS. No additional 
hardware is required.  
 

Setting the DGPS mode to ‘None’ will set the VVB to use GPS signals only. 
 
If any of the incorrect settings are entered, or a Base Station is not detected when required, only GPS signals will be 
used. 
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Serial Application 
By default, the Video VBOX is setup to communicate with an OLED display via the Serial Port.  
You can change this to work with the DriftBox using this option.  

Log settings 
The default filename for Videos and ‘.vbo’ files is 
VBOX0001.avi and VBOX0001.vbo. You can change 
this prefix using the Log Settings tab, or choose to 
use the Time and Date instead. 
e.g.VBOX_20100803153038_0001.vbo 
Which is 
[Year][Month][Day][Hour][Minute][Second]. 

Logging Modes 
Only when moving: Logging will commence when speed exceeds a configured value and cease when the 

vehicle has remained stationary for a configured value. Default setting is 2.5km/h and a Stop log delay of 3 seconds.   

Continuous: the Video VBOX will commence logging as soon as media becomes available.  

Manual: Logging will only start/stop by pressing the REC button. 

CAN: Logging will be controlled by a set of configured CAN parameters.   

Geo Fencing 

This allows the logging function of the Video VBOX to be linked to a defined geographic location. A Google Earth KML 
file (with a maximum number of 50 points) can be loaded here. This will set the Video VBOX to only log inside or 
outside the defined area.  
 
If the region conditions are not met, the Video VBOX will not log at all – it will not respond to the REC button on the 
front panel. Once the geo-fencing conditions are OK, then the unit will use the logging settings as set and operate as 
normal. 

CAN logging control 

Logging can be controlled over the CAN bus using this setup 
screen. Firstly setup a CAN channel in the CAN and module 
configuration tab, and then select this channel in the logging 
control. 
The conditions for starting and stopping the logging can then 
be defined. 

Digital IO Event Marking 

By default, the Digital IO mode is set to control logging from a Remote Start/Stop switch. This can also be configured 
so that instead of controlling logging, an Event Marker will be set in the .vbo file whenever the button is pressed. 

Video Settings 
If No camera no video is enabled, disconnecting all cameras stops 
the ‘.avi’ video file from being created, but the ‘.vbo’ data-logging 
file is still written. This tab also allows you to change between NTSC 
and PAL (default) and also set the Video Quality (default high). 

Video Quality storage requirements 
High:  ~2Gb per hour 
Medium: ~1.8Gb per hour  
Low:  ~ 1Gb per hour  
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Audio Settings 
By default two channels are enabled for Audio, but if you only 
have one microphone, then set audio to Mono, and the sound 
will then be recorded on both channels. 
 
ALC Sensitivity, this is the Auto Level Control and by default it 
is set to high. By setting to Off you can then manually adjust 
the gain, which is useful for more precise line input control. 

Camera settings 
By default the unit works with Camera 1 as the 
main picture, and additional cameras appear as 
picture in pictures.  
 
By setting Four camera quadrant mode, all four 
cameras are divided up equally in a square. 

 
Floating camera option allows for all camera inputs to be assigned to a Picture in Picture element, opposed to one 
main shot with secondary PiPs on layered on top. 

CAN 

Defining a CAN channel 
Video VBOXs can connect to the CAN bus of your vehicle to log and display additional parameters such as RPM, 
Throttle angle and Brake pressure. In order to do this, the protocol for the particular vehicle must be entered into the 
Scene Properties under CAN and module configuration.  
 
If you wish to connect to your vehicles CAN bus system, please download the relevant CAN file from the Racelogic 
website. Once you have the correct CAN file, to setup a CAN channel for your vehicle, click on Load under Inputs. 
 

Now click on Load database file and select the file for your 
vehicle. 
 

 
 
 
Some CAN files available are for multiple vehicles. 
By selecting the RPM only list, the number of options is vastly 
reduced, and the vehicle make is defined in the first 3 characters of 
the parameter, such as POR for Porsche, REN for Renault etc. Some 
cars are listed by the model.  
 
Select the closest match to your vehicle and click Apply. A Can 
channel will then be assigned to this CAN message. 

CAM 1 CAM 2 

CAM 3 CAM 4 
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Assigning a CAN channel to an Element 
 
To display a CAN channel, select the chosen Element, 
Open the Element’s properties and select CAN from the 
pull down list under Parameter.  
 
A list of all the defined CAN channels should then appear 
below, select the channel you wish to display. 

 

Using your own database (.dbc) file 
 

Under CAN and module configuration, select 
Load, and then Load database file. 
 
 
 

 
Your Database file will then be displayed and you can tick the boxes 
alongside the message you wish to assign to a CAN channel. If you tick 
multiple boxes, then multiple CAN channels will be assigned. 
 
The CAN channel can then be assigned to an Element in the same way 
as described in the previous section under ‘Assigning a CAN channel 
to an Element’. 
 
You can change the CAN channel by clicking on the channel in the 
CAN tab. 

 
 

 
 

 
 
 

 

 

Loading a CAN Database from Element Properties 
The database file can also be loaded by selecting CAN and Modules from the 
Parameter drop-down in the element’s Properties tab.  
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Advanced CAN Options 

CAN Baud Rate 

The default Baud rate of the Video VBOX is set at 500 KBit, the user has the option 
of selecting 100, 125, 250 or 500 KBit, and 1MBit. 
 

CAN Mode 

The VCI CAN mode should be selected if the Video VBOX is to be connected to a 
vehicle CAN bus.  

The VCI CAN mode + Send acknowledge box should be selected if the Video 
VBOX is to be connected to any modules such as the ADC03. 
 
The Racelogic Output mode should be selected if the Video VBOX is to be connected to a CAN logging device. If this 
mode is selected, the Video VBOX will transmit GPS channel data onto the CAN bus. 

Send Acknowledge – Racelogic modules and other CAN data-loggers and sensors require an acknowledge pulse to be 

sent. However, it is not recommended to send these messages when connected to a vehicle’s CAN bus. 

 

 

Manual Editing of CAN Parameter Fields 

If you know the format of the CAN messages you wish to log, 
then click on the CAN channel that is to be modified and click 
Advanced Options. 

 

 

Logging Raw CAN 

Raw CAN data can be logged and assigned to a Text Parameter element. A CAN database is not required. 
 
To set up a Raw CAN channel, ensure that VCI 
mode is selected, Send Acknowledge is un-
checked and Baud Rate correctly set. Select an 
Empty Input Channel and then Edit channel 
manually. 
 
Check the Log raw CAN data check-box and enter 
the ID to be logged. Click Apply and the channel 
will be available to assign to a Text Parameter 
element. 

 
Note: Raw CAN data will only be 
displayed on the overlay. The Raw 
CAN channels are not compatible 
with VBOX Tools Software. 
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Connecting to the Vehicle CAN Bus 
If the Video VBOX is to be used to log and display CAN data from the vehicle, the Video VBOX needs to be connected 
to the vehicle’s OBD (On-Board Diagnostics) port or directly into the CAN bus depending on the model. Most vehicles 
have an OBD connector which provides this interface. 
 
The exact location of the OBD connector varies from vehicle to vehicle, but it will be within a few feet of the driver and 
it will have easy access.  Most often you can find your OBD connector somewhere below the steering column, either 
above the pedals or perhaps inside a fuse box by the driver's knee. Your OBD connector will probably be in plain view, 
but some connectors are covered. 
 
Note: If a connection needs to be made to the Vehicle CAN Bus, we strongly recommend contacting a qualified auto-
electrician to perform the fitting. 
 

Configuring the Video VBOX to use a Mini/Micro Input Module 
You can also use a Racelogic Input module to log external signals such as RPM, Throttle angle etc. 
 

To work with a Mini/Micro Input Module, set CAN mode to VCI. 
 
 

 
Under CAN and module configuration, the quickest method is now to 
enable Log All in the relevant tab. This will now log every channel in 
the module in the default units (volts and Hz). 
 
 
However, if you want to configure the module in more detail (i.e. 
change units and scaling) then open up the relevant tab, either Mini 
input module or Micro input module.  
 

 
You can now configure each channel by clicking on the button. 
 
The name, units, scale, offset, maximum and minimum can 
then be defined. 
 
 
 
 
 
 

 
 
 
 
PLEASE NOTE: You cannot log from the vehicle CAN Bus at the 
same time as using a Micro or Mini Input Module. 

  

Click on button 
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Setting up a Video VBOX for use with other Racelogic modules 
Compatible Modules: ADC03, ADCO2, IMU02, IMU03, YAW02, YAW03, FIM02, FIM03, TC8, IMU04. 

Note: We recommend using terminating resistors with Racelogic modules. Lemo connectors with built in terminating 
resistors can be purchased from Racelogic. (RLACS165 – Standard Lemo, RLACS165-S – Splash-proof Lemo) 

To log data from a module, you need to load in the CAN module database.  
 

 
 
In Scene Properties expand CAN and module configuration then Inputs.  
 
Please download the relevant CAN file for your Racelogic module from 
the Racelogic website. 
 
 
Once you have the correct CAN file, to setup a CAN channel for your 
vehicle, click on Load under Inputs. 
 

 
 

 

When you have opened the relevant .dbc file, you have to select the channels you wish to log.  
 

 

To do this, you simply expand and then tick the desired channels. 
When you have selected all the channels you need 
click ‘Apply’.   

  

 

 

 

You will now see the selected channels appear under the ‘Inputs’ section under the ‘CAN and module configuration’ in 
scene properties. These are now loaded and will be logged to the VBO file. They can also now be assigned to an 
element.  

PLEASE NOTE: You cannot log from the vehicle CAN Bus at the same time as using a Racelogic 
Input Module.  
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Assigning a Module channel to an Element 
 
To use an Input Module channel with an element, 
select Mini input module from the Parameter list when 
creating the element. The list of Input Module channels 
will then become available for selection in the 
parameter drop down list. 
 
 
 

Setting up the Mini Input Module for use with the Video VBOX 
To ensure the Mini Input Module has the correct settings for use with the Video VBOX the correct settings may have 
to  be uploaded into the MIM using the Stand Alone Setup Software and loading in the ‘vbmim01_vvb.rms’ 
configuration file available from the software download section of the VBOX website. 
 

Displaying DriftBox Parameters 
The Video VBOX does not produce Drift Angle or Score, you must have a Racelogic DriftBox and a CAB045 (Pro) or 
CAB098 (Lite) serial-to LEMO Cable to provide the Drift Angle and Score data to the Video VBOX. 
 
To select either Drift Angle or Score for use as an Element data source: 
 

1. First select DriftBox in the Serial Application dropdown under 
Scene properties 
 

2. Select the relevant element in the scene 
 

3. In the Parameter Selection dropdown select DriftBox 
 

4. Select Angle or Score 
 

Recommended Software Tools 
Listed below are a few suggestions for some software packages/tools that can be used in conjunction with the Video 
VBOX setup software. 

Video Players: 

VLC player Free  Video player of most video formats. 

Irfanview Free  Image editing and video utility. 

Design Tools: 

Adobe Illustrator ££  Vector graphics creation and editing tool. 

Adobe Photoshop ££  Image editing Software. 

Gimp Free Vector graphics creation and editing tool. 

Inkscape Free Vector graphics creation and editing tool. 

Video Repair Tools: 

DivFix++ Free Tool for fixing corrupt or damaged AVI files. 

Codec packs: 

Xvid Free  XVid Codec pack is installed with video VBOX setup software, but is 
available for download off the web. 

http://www.velocitybox.co.uk/index.php/en/support/40-software.html
http://www.velocitybox.co.uk/index.php/en/support/39-firmware.html
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APPENDIX 1: Calculating scale and offset of an Input parameter 
This article shows how to convert the data from a Mini/Micro input module into a more meaningful format, for 
example converting a voltage from a throttle or brake pedal into something more useful like a throttle pedal 
percentage 0-100%. 
 
It should be noted that this calculation only works for linear data where the plot of the data produces a straight line. 
 
We have a ‘scale and offset calculator’ on our website at www.vboxmotorsport.co.uk. 
 
1: Obtain zero and full scale voltage values 
For example, say the throttle position sensor gives 
0.5 volts on closed throttle, and 5 volts at full 
throttle.  
 
To convert this into a percentage, the equation of the 
straight line needs to be calculated. 
 
The equation describing a straight line is as follows: 
 
Y = mX + c 
 
Where; 
 Y = The Y values  (% pedal press) 
 X = The X values  (sensor voltage) 
 m = scale  (gradient of the line) 
 c   = offset  (intercept with the Y-axis) 
 
 
 
 
 
2: Calculate the gradient of the line 
The gradient of a line is the change in Y divided by the change in X which gives: 
 
 m (gradient) = dY/dX (change in Y) / (change in X) 
 
 dY = 100 – 0 = 100 change in Y = 100% - 0% = 100 
 dX = 5 – 0.5 = 4.5  change in X = 5 volts – 0.5 volts = 4.5 
 
Therefore the gradient of the line is: 
 
 dY/dX = 100 / 4.5 
             = 22.22  The Scale is 22.22 
 
3: Calculate the offset 
To find the offset value, substitute the known values at zero throttle, back into the equation: 
 
Y = percent = 0, X = Voltage = 0.5 V 
 
 Y = mX + c  Therefore 
 
 0 = (22.22 * 0.5) + c Zero throttle% = gradient x 0.5 volts + Offset 
 0 = 11.11 + c    
 C = -11.11  The Offset is -11.11 
 

http://www.vboxmotorsport.co.uk/index.php/en/customer-area/useful-video-vbox-pages/9-customers/68-calculators
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4: The full equation for the line 
Substituting these values back into the equation again gives us the full equation of the line which passes through our 
two points. 
 
 Y = 22.22X – 11.11 
 
5: Checking the equation 
We can double check our equation is correct by calculating a percentage value for a known voltage output. 
We know that: 
 
 
 
 
 
Using the equation we have just derived produces the following results: 
 
 Y = 22.22X – 11.11 
 Y = (22.22 * 0.5) – 11.11 = 0%  This is correct, as 0.5 volts is equal to a 0% pedal press. 
 Y = (22.22 * 5.0) – 11.11 = 99.99%  This is also correct as we know that 5 volts = 100% pedal press. 
 
 
8: Plotting the full line 
The graph below illustrates the calculated scale and offset 
values. 
 

  

 
 
 
 
 
 
 

Voltage (x) Percent Pedal Press (y) 

0.5 0 

5 100 


